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Language Arts/Drama

Grades:  9-12

A Story Too Simple?
Creating a Subplot for Romeo and Juliet

Tools

Kit software:  Inspiration;

Romeo and Juliet

Other:  Computers; the

Internet; AppleWorks; iMovie;

a digital camcorder

Optional:  The Writing Trek

Project Duration

Eight to nine sessions over about two weeks

Introduction

Subplots in Shakespeare are very important, often intersecting with the main action to spur its

unfolding. Romeo and Juliet is rare among the plays of Shakespeare in that it has no subplot. Every

event contributes to the main action of the story. How can we help students enter imaginatively

into the role of playwright to craft the “missing” subplot? How can the use of storyboarding tools

free students to build a concrete understanding of the play’s characters and story?

Project Overview

In this project, students learn about plots and subplots and analyze the plot and characters of

Romeo and Juliet using AppleWorks and Inspiration. They then invent subplots for the play,

select single scenes from these subplots, script them, and produce the scenes as iMovies

published on the Internet.

Phase 1: Finding the subplots of daily life

Ask students to begin reading Romeo and Juliet in traditional print form, using their journals to

keep a summary of the main events of the story.

When students have read a significant portion of the play, discuss with the whole class the concept

of plot as a particular telling of events, using Romeo and Juliet as an example (see the Facilitation

Tips section for Phase 1). Then invite students to think about their lives as stories, with many

threads running through each day and each week. In this context, introduce the concept of

subplot. Which thread of students’ lives, from their point of view, is the main plot? Achieving in

school? Sports? Music? Romance? With the main plot known, what other events become subplots?

After the discussion, ask students to write short answers to these questions in their journals.
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Phase 2: Plotting the play and the characters

While students finish reading the play outside of class, small groups meet in class to create outlines

of the action of the story, using the AppleWorks “Events Chart” template. (See the “Events Chart

Template” on the kit Web site.) For each event in the story, groups describe the participating

characters, the setting, and the consequences of the event. Each group also uses the Inspiration

“Character Relationships Map” template to create a diagram that shows direct and indirect

relationships between characters. (See the “Character Relationships Map” template on the kit

Web site.)

Meanwhile, groups take turns using the Romeo and Juliet CD to clarify their understanding of the

play and to refine their Events Charts. Focusing on parts of the play about which they are least

confident, each group reviews the script, checks the meaning of unfamiliar words, reads the

paraphrases of each scene, and watches videos of scenes being performed.

Phase 3: Building a subplot

Groups compare their completed Events Chart with their Character Maps, looking for character-to-

character relationships. They then brainstorm ideas for subplots to add to the play. Will they add a

character? Will they make changes to the main plot?

Each group selects one subplot idea and discusses how it will fit into the play. The group then

outlines its subplot by modifying its Events Chart, adding events to the existing play that together

constitute new scenes, and altering Shakespeare’s events as necessary.

Phase 4: Presenting Romeo and Juliet Plus!

Groups select one of their new subplot scenes to script and act out. Using the modified Events

Chart as a guide, the group writes (in AppleWorks) the action and dialogue of the scene (using as a

model the script in Romeo and Juliet). Group members choose roles and rehearse their scenes,

revising the script if necessary.

Next, groups produce their scenes as desktop movies, using a digital camcorder and iMovie. Each

movie begins with a “chorus” (as in Romeo and Juliet) explaining the whole subplot, the location

in the play in which the scene fits, and how the scene works in the subplot. The completed iMovies

are published on the Internet for easy viewing by students, family members, and members of the

school community.

Technical and Facilitation Tips

Facilitation Tips: Phase 1

m You may want to have students read the play outside of class.
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m Story and plot are two distinct concepts. The story is the sequence of all events that take place;

the plot is the way that those events are revealed. Before the opening scene in Romeo and

Juliet, for example, several things have happened: something (we don’t know what) has started

a feud between the Montagues and the Capulets, and Romeo has been smitten with a girl

named Rosaline. But the play itself is plotted in such a way that we, the audience, learn of these

events after they have taken place. On the other hand, stories can sometimes be plotted in ways

that enable the audience to learn of key events while characters remain ignorant of them. We

know, for example, that Juliet has taken a potion so that she can feign death, but Romeo never

learns of this.

m Students may find it interesting to review their daily lives in terms of plot, but they may not be

open to revealing their observations. Consider inviting students to write, on small pieces of

paper, one-word titles for their daily-life main plot and for one or two subplots. These can be

drawn out of a hat and read out loud to spur discussion.

m The class discussion portion of Phase 1 will occupy one class session or part of one session.

Facilitation Tips: Phase 2

m Students can use a blank, printed version of the Events Chart template to chart the events in

Romeo and Juliet while they read the play in book form outside of class. When groups meet in

class to work on the Events Charts on the computer, students’ handwritten charts will be useful

starting points. Similarly, when groups work with the Romeo and Juliet CD, printed versions of

the group’s Events Chart can be used to note modifications and additions that can be entered

into the chart when the group works with its chart on the computer.

m The Events Chart asks students to give each event a number, and to note whether it takes place

onstage or offstage. Students describe each event, and then note the character, the setting, and

the consequences of the event. The Consequences category is particularly important: in it,

students can describe an event that occurs in response, or as a result of, the current event being

described; they can also list the number of that event if it appears on their Events Chart.

m As they use the Romeo and Juliet CD, encourage students to explore the videos of Shakespeare

experts talking about perspectives on the play, its use of language, and the theatrical practices of

Shakespeare’s time. (These can be accessed by clicking the Presenters icon on the Main Menu

screen.)

m After groups create the framework of their Character Relationships Maps (character names and

short descriptions of the relationships), encourage them to add other types of information by

considering questions such as these: What is each character’s central trait and driving motive?

How does each character directly affect the thought, actions, and circumstances of other

characters? This type of information can be added to the objects that stand for each character.

m Guide groups in understanding Romeo and Juliet as a chain of actions, responses, and

consequences. It is, of course, important who the characters are, but what they do is at the

core of the play. (See the Background Information section regarding the importance of plot to

tragedy.) Could any events be left out of the plot and let it still reach the same conclusion?

m Groups may require two class sessions or more to complete their Events Charts and to spend

enough time with the Romeo and Juliet CD.
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Tech Tips: Phase 2

m To list all the events in the play, students will need to add rows to the end of the AppleWorks

Events Chart table. To add new rows, leave the last row of the table blank and then follow these

steps:

1 Click in the left-most cell of the last table row and drag the pointer across the row to highlight

all the cells.

2 Choose Insert Cells from the Table menu. A row is added to the table.

3 Repeat step 2 as needed to add the number of new rows you want.

For more help, see the Step-by-Step Card “Creating Tables With AppleWorks 6.”

m The Character Relationships Map is intended as the beginning of a more complete map.

Students should add characters and links as necessary. Different colors and shapes can be used

to distinguish Capulets and Montagues, men and women, minor characters and major

characters.

m In the Character Relationships Map, relationships between characters are represented by links.

Inspiration allows students to create labels for these links, such as “best friends” or “mother-

daughter.” To add a label to a link, click the link and then type the text for the label.

m The Romeo and Juliet CD includes the original play, along with a modern paraphrase to assist

students’ understanding. To read the paraphrase, students click the Paraphrase button to the

right of any scene. Clicking the Summary button plays a movie of two experts summarizing the

scene.

m The Romeo and Juliet CD presents videos of key scenes. From the text of the play, students

access these videos by clicking the movie clapboard icon. The portions of the play that have

corresponding video are marked with red underlining. Another way to access the videos is to

click Performances on the Main Menu screen.

m Using the Romeo and Juliet CD, students can move the pointer over words and phrases in blue

to see modern synonyms.

Facilitation Tips: Phase 3

m Be sure to have groups save copies of their completed and unmodified Events Charts. Groups

may need to use these for reference while outlining their subplots, and you may want to

compare them with the subplot-modified Events Charts when you assess groups’ work.

m As they begin thinking about their subplots, groups should consider the various characters, their

actions, and relationships (as outlined in their Character Relationships Maps). They can also be

on the lookout for characters who drop out of the action for a period, for minor actions that

might be assumed by a more major character, or for openings for new relationships among

characters. A few ideas:

m Friar John is prevented by an outbreak of plague from delivering news that Juliet is feigning

death. Could his mission be carried out by a more central character, such as the Nurse? Or

Friar Laurence himself? What obstacle might arise to thwart this messenger? Could this be

the basis for a subplot?

m The County Paris, who is underdrawn in the play, might be involved more substantially in the

action: he could, for example, be in love not with Juliet, but with her mother, Lady Capulet.
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m And what of Rosaline, who never even appears in the play? Perhaps she is a good friend of

Juliet’s (she is invited to the Capulets’ party, after all), or perhaps she is in love with Tybalt,

and at his death begins scheming revenge on Romeo.

m To outline each new scene of its subplot, each group will need to determine four main things:

who is involved; what do the characters do; where do the events take place; and when do the

subplot scenes happen in relation to events in the main plot.

m Be sure students understand that their subplots must have bearing on the main plot. Each

subplot should depend on character interrelationships and character actions, and should,

ultimately, tie back into the tragic story of Romeo and Juliet.

m Suggest that when students begin adding subplot events into their Events Charts that they use a

different numbering system (such as letters or Roman numerals) in the left-hand column,

rather than changing all the numbers in the chart. In addition to being easier, this technique will

help distinguish the added subplot events from Shakespeare’s events.

m Subplots may be of varying lengths. You may want to communicate some expectations,

however. A suggested minimum length is two separate scenes, each consisting of three or four

events (as listed in the Events Chart).

m This phase will require about two class sessions to complete.

Tech Tips: Phase 3

m To add new events to an existing AppleWorks Events Chart, students need to insert new rows

into the table in specific locations. The most important thing to understand about inserting rows

into a table is that the new row gets added above the row that is selected. To insert a new row,

follow these steps:

1 Click in the left-most cell of the row below which the new row should be inserted, and drag

the pointer across the row to highlight all the cells.

2 Choose Insert Cells from the Table menu. A new blank row is inserted above the highlighted

row.

Facilitation Tips: Phase 4

m Students can try to emulate Shakespearean English as closely as they choose. However, you

may want to stress that the point is to write good dramatic dialogue, not to duplicate archaic

speech patterns.

m If a group’s scene has fewer characters than group members, the group members who are not

rehearsing the scene can take on the role of director(s), offering constructive criticism to the

actors. When the group performs its scene in front of the digital camcorder, the non-actors can

operate the camcorder. In addition, a non-actor can be the “chorus” who introduces the scene

to the audience and explains where it fits in the play. In this way, all group members will have an

active role throughout this phase.

m Groups can dress in costume for the filming of their scenes.

m Groups can add background music tracks to their scenes using iMovie.
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m Students will need at least two class sessions to script and rehearse their scenes; performances

of the scenes can be recorded in one class session and edited in one to two class sessions

(depending on previous experience with iMovie). To reduce the amount of class time

dedicated to script writing, you may want to ask students to do some of this work outside of

class.

Tech Tips: Phase 4

m For help using iMovie, visit the “Desktop Movies in Education” Web site.

m The desktop movies of student performances can be published easily on the Internet by setting

up an Apple iTools account and using the iMovie theater template for your Web site. For

complete instructions, see the Step-by-Step Cards “Setting Up an iTools Account,” “Creating a

Web Page With iTools HomePage Templates,” and “Using Your iMovies With iTools

HomePage Templates.”

Outcomes

After completing this project, students will be able to:

m discuss narrative works in terms of structure and plot

m map character relationships in Romeo and Juliet and other works

m describe Romeo and Juliet as a chain of events and consequences

m summarize the plot of Romeo and Juliet

m explain the difference between a story and a plot

m discuss the role of a subplot in relation to the plot

m write a script for a scene in a play

m act out a scripted scene

In addition, students will have

m created original stories that reflect narrative structure

m considered the difference between life and art

m explored Romeo and Juliet as an act of choice and design on the part of a particular writer

m gained experience filming and editing a movie

m learned skills or acquired knowledge relating to each of the state and national standards referred

to in the Project Standards section

Project Standards

From the Secondary Language Arts & Social Studies Web site, you can identify select state

curriculum standards and national educational technology standards that correlate to this student

project. To locate these standards, go to the kit Web site and click the Curriculum button. Locate

and open this student project and click the “Project Standards” button.
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Assessment Suggestions

Any combination of the following methods can be used to assess student work in this project:

m Groups’ Events Charts (Phase 2) can be assessed for accuracy in terms of the sequence,

characters, actions, and consequences of the major events of the play.

m Groups’ Character Relationships Maps (Phase 2) can be assessed according to their reflection

of the schism between the Montagues and Capulets that dominates the play.

m In Phase 3, subplot outlines (as represented by groups’ modified Events Charts) can be

assessed according to how well they focus on events, describe a chain of action and reaction

that leads to a conclusion, have bearing on the main action of the play, and show clear and

straightforward writing.

m In Phase 4, groups’ scripts can be assessed according to how well they show originality, have

plausible character motivation, set an emotional tone, and convey the subplot events clearly and

economically.

m In Phase 4, groups’ performances can be peer-assessed using a teacher-created rubric.

Preparation

m Print blank copies of the Events Chart for every student so that they can use them outside of

class, while reading the play, to draft outlines of the play’s action.

Resources

Internet

Center for Digital Storytelling Cookbook

http://www.storycenter.org/memvoice/pages/intro.html

The Complete Romeo and Juliet Online

http://www.chemicool.com/Shakespeare/romeo_juliet/index.html

Creative Writing for Teens: Character Development

http://www.teenwriting.about.com/teens/teenwriting/cs/names1/

Desktop Movies in Education

http://www.apple.com/education/dv/

EdView

http://edview.apple.com

The Elizabethan Glossary (part of About.com’s Shakespeare site)

http://shakespeare.about.com/arts/shakespeare/library/blglossary.htm

Mr. William Shakespeare and the Internet

http://daphne.palomar.edu/shakespeare/

Romeo and Juliet (from a thinkquest entrant)

http://library.thinkquest.org/19539/randj.htm
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Screen-Writing Seminar

http://www.alta-films.com/Kemp/screenwriting_seminar.htm

TVPitch.com The Basics

http://www.mandalay.com/tvpitch/basics.html

Westside Story—Overview

http://movie-reviews.colossus.net/movies/w/west_side.html

Westside Story Review from The Greatest Films

http://www.filmsite.org/wests4.html

Step-by-Step Cards

m Creating a Web Page With iTools HomePage Templates

m Creating Tables With AppleWorks 6

m Getting Started With Inspiration

m Setting Up an iTools Account

m Using Your iMovies With iTools HomePage Templates

Templates

m Character Relationships Map

m Events Chart Template

Additional Resources

Organizing Information With Inspiration

Prerequisite Skills

To complete this project successfully, students should be able to do the following:

m use a mouse to navigate through a multimedia application by clicking icons and links

m use AppleWorks to edit simple word-processing documents

m edit and insert rows into tables in AppleWorks (see the Step-by-Step Card “Creating Tables

With AppleWorks 6”)

m make and modify a basic concept map using Inspiration (see the Step-by-Step Card “Getting

Started With Inspiration”)

m edit digital video with iMovie (see the “Desktop Movies in Education” Web site)
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Background Information

Here is some information you may find useful as you plan how to implement this project or

introduce it to your students:

m In his analysis of tragedy, The Poetics, written in the third century B.C., Aristotle identifies six

formative elements in drama: spectacle, character, plot, language, melody, and thought. Of

these, he says, plot is far and away the most important element, because “Tragedy is essentially

an imitation not of persons but of action and life, of happiness and misery.” (You may want to

discuss this statement with the class, in relation to Romeo and Juliet. In any case, it will help

students’ appreciation of the play to understand it as a chain of events in which action, reaction,

and coincidence intersect at Juliet’s tomb in a scene of great pathos, or emotional effect.)

m Shakespeare wrote Romeo and Juliet in 1597. The story of the tragedy is innovative in that it is

based on a structure that, until that time, had been employed most often for comedy. As he

does in his early play, The Comedy of Errors, and in later comedies that include As You Like It

and The Tempest, Shakespeare tells the story of two young people whose love is blocked by

the quarrels and rules of an older generation. In the comedies, the passion and purity of the

young lovers breaks down the obstacles created by society’s irrationality; in Romeo and Juliet,

the ruptured society is too much to overcome, and the heroic couple’s love ends in tragedy.

m Subplots are common elements in narrative. In Shakespeare’s plays, subplots often intersect

the main plot near its end, and spur the play on to its conclusion. Hamlet’s romance with Ophelia

is not directly related to his investigation of his father’s death. However, when it leads to

Ophelia’s suicide, her brother Laertes embarks on a quest for vengeance that leads to the duel

at court in which Hamlet exposes Claudius, and that leaves all the major characters dead. In

King Lear, the exiled Edgar, disguised as a madman, meets Lear, also exiled, in the middle of

the storm; he shelters the king, then disappears, returning in armor to defeat his bastard brother

Edmund, and to heal the divisions and strife that have ripped through England.

Options and Extension Activities

Options

m Invite a director from a local repertory company or university drama department to discuss

Romeo and Juliet and Shakespeare from the director’s point of view.

m Inspiration includes a Character template that is useful for understanding characters in isolation,

as composites of different qualities as illustrated in the play. Students may want to use this

template to refine their ideas of Romeo, Juliet, or another character. To access this template,

choose Template from the File menu, then scroll through the list to find the Language Arts

Character template, then click Open.

m Students can work individually or in pairs to learn about plot in The Writing Trek. The Concepts

section of the Story Place deals specifically with this element, along with character, setting,

theme, dialogue, and the narrator. For the Try It activity, substitute an activity in which students

identify the Set Up, Trigger Event, and Climax (all identified in The Writing Trek) for Romeo

and Juliet. Students can also learn about theatrical concepts in The Writing Trek’s Theater.

m Students can compare Romeo and Juliet to a Shakespeare play that has a subplot, such as

Hamlet or King Lear.
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m If a digital camcorder is not available, pairs can perform their scenes for the whole class live.

m The desktop movies created in Phase 4 can be used as the basis of discussion about drama,

acting, dialogue, and narrative.

m When students are done editing their movies in iMovie, they can copy the movies back to the

digital camcorder, connect the camcorder to a VCR, and then copy the movies to a videotape.

The videotapes can then be taken home for viewing with family members.

Extension Activities

m Students can create subplots for another well-known Shakespeare tragedy, Macbeth, which,

like Romeo and Juliet, has no subplots.

m Groups can write scripts for all of the scenes that make up their subplots.

m Students can read or view on videotape the musical West Side Story, which transfers the story

of Romeo and Juliet from Verona to Manhattan, and from the Montagues and the Capulets to

the Sharks and the Jets. Groups can brainstorm other situations that might make interesting

settings for this classic story, then create multimedia storyboards to pitch their ideas to a film

producer.

The Home-School Connection

m After they have become familiar with the story, invite students to check a videotape of Romeo

and Juliet out of the school or public library and view it at home, sharing their knowledge with

family members.

m Invite family members to view the completed desktop movies of students’ scenes on the

Internet, or on VHS tapes taken home by students (see the Options section).

This Project as a Model

This project demonstrates how various technologies can enhance the appreciation and analysis of a

Shakespeare play: an editable AppleWorks table is used to outline the plot; Inspiration is used to

chart character relationships; and iMovie is used to capture student performances related to the

play. These tools can play similar roles in the study of other Shakespeare plays, or of other works of

literature with a strong narrative structure.


